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The operation and functions described in this manual are available from AV-AMP version 1.2 and above.
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1 Introduction 

1.1 Cautions and Warnings 
 

STOP

 

Before commencing with installation or operation of this AV-AMP software, please 
read this manual carefully. If you are unclear on any point, DO NOT proceed. 
Contact Advanced for clarification and guidance.  

 

 

Only Advanced trained service personnel must undertake the Installation and 
Programming Procedures as described in this document.  Individuals not certified 
by Advanced are not authorized to utilize the Advanced AV-AMP Programming 
Tool. 

1.2 Minimum Computer Requirements 
Processor: Pentium 300MHz 

RAM:  64Mbyte RAM 

Hard Disk: 10Mbyte free disk space 

Operating System:  Windows® 95, 98, ME, 2000, XP, Vista*#, Windows 7*# (32 and 64 Bit Windows Operating 
System) and Windows 8 / 8.1 

* Vista and Windows 7, 32 and 64 Bit Operating System, User Account Control (UAC) must be turned off during 
AV-AMP installation. 

Display Minimum:  600x800 16-bit Color, 1024x768 recommended. 

Note: If utilizing Windows Vista or Win 7, after installation of the program you must setup to run the 
program as an administrator.  In the “Start” menu “All Programs” under “Dynamix Tools” right click 
“AxisAx AV-AMP”, select “Compatibility” tab under “Privilege Level” select Run this program as an 
administrator.  Select “Apply” than “OK”.  You are now set to run the program as an administrator. 
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1.3 Installing the Program 
With the exception of the AV-AMP version 0.1.9 or earlier, required for use with pre AV-AMP-80 rev 8 (RS485) 
PCB’s, uninstall any other AV-AMP program from your computer prior to installation. 

Note:  When uninstalling a previous Dynamix Tools AV-AMP version, you must utilize the Windows 
Uninstall a program. 

 

Install the new AV-AMP setup file on your computer hard drive, where you store all your other Advanced’ files. 
Launch the installed program, the program will guide you through the installation process. Follow all of the on-
screen instructions. 

2 General Operation 

2.1 Running the Program for the First Time 
To run the program, navigate to the “Dynamix Tools” file (Windows Start, All Programs, Dynamix Tools) and select 
“AxisAx AV-AMP”. 

 

Alternatively, only if the file was created with version 1.2 or later use Windows Explorer to locate the required AV-
AMP data file and double click on the file name to automatically launch the program. 

If starting a new program, once you select “AxisAx AV-AMP” and the program has completed loading, a new 
window will appear where the user can begin programming a new file.  

Note:  An AV-AMP version 0.1.9 file cannot be opened in an AV-AMP version 1.2 or higher programming 
tool. Version 0.1.9 and earlier files are for non PBUS (RS485) amplifiers (rev 7.5 or earlier). 

2.2 Screen Layout 
The AV-AMP screen layout is shown below. The main elements of the display are indicated and explained in the 
following sections. 

1 – Action Icon Buttons 

2 – Program Tabs and Program/Control Icons 

3 – Panel/Amplifier List 

4 – Message Program Area 

5 – Message Categories 

6 – Category Messages 
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2.2.1 Action Icon Buttons  

Action Icon Buttons include;  New (Ctrl+N),  Open (Ctrl+O) and  Save (Ctrl+S) 

New:  Create a new file 

Open:  Open an existing file 

Save:  Save the current file 

2.2.2 Program Tabs and Program/Control Icons 

Program Tabs include;  File and  Home. 

2.2.2.1 File Tab 
The File Tab allows the user access to File Control Icons. 

2.2.2.1.1 File Control Icons 
The File Control Icons within the File Tab area include; New, Open, Save, Save As and Close. In addition to the 
File Control Icons, the File Tab area includes a Recent Files area, allowing the user to reopen previously 
programmed files. 
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2.2.2.2 Home Tab 
The Home Tab specifically allows the user access to file Program/Control sections. Program/Control sections 
include; Clipboard, Panel, Audio and Communications. Within each Program/Control section, there are dedicated 
icons for user programming and control. 

 

Note:  Certain Program/Control section icons are non-accessible (grayed out) until the usage option is 
available. 

Upon initial opening of the AV-AMP, only three Program/Control Section Icons are accessible, two (Add Panel, 
Add AV-AMP) within the Panel section and one (Import Audio File) within the Audio section, the remaining icons 
are grayed out (non-accessible) until the usage option is available. 

2.2.2.2.1 Clipboard Icons 
Clipboard Icons include; Paste, Cut and Copy. The Paste icon is only accessible after an 
item has been copied. The Cut icon is only accessible when the item selected can be cut 
(i.e. a panel, an audio message, etc.). 

2.2.2.2.2 Panel Icons 
Panel Icons include; Add Panel, Remove Panel, Add AV-AMP and 
Remove AV-AMP. Prior to programming, the only icons accessible are 
Add Panel and Add AV-AMP, the Remove Panel and Remove AV-AMP 
are only accessible when the user clicks on a Panel or AV-AMP already 
added to the installation. The user is capable of adding any number of 
Panels and/or AV-AMPs to the Panel/Amplifier List. Each Panel and/or 
AV-AMP added to the list will contain a customizable label area, 
accommodating up to 32 characters. Customizable label areas are for 
defining Panel and AV-AMP locations.  

2.2.2.2.2.1 Add Panel 

By selecting the Add Panel icon arrow, the user is capable of 
selecting Add Command Center, Add panel with integrated audio or 
Add panel without integrated audio. Both the Command Center and 
the Panel with integrated audio include an AV-AMP, while the Panel 
without integrated audio does not. 

The reason there is a Panel without integrated audio selection, is so 
the user can assign PBUS remote AV-VBs to a Panel that has no 
integrated AV-AMP.  
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2.2.2.2.2.2 Add AV-AMP 

By selecting the Add AV-AMP icon arrow, the user is capable of selecting AV-
VB or AV-VBM. The Add AV-VB to panel and Add AV-VBM to panel are non 
accessible (grayed out), unless a panel has been previously added to the 
Panel/Amplifier List area. 

Note:  Add AV-VB and AV-VBM to panel selections include; pre-populated 
integral network AV-AMP amplifiers, for use with the Advanced AX-CTL 
base card PBUS (RS485) network. Non panel AV-VB and AV-VBM are pre-
populated standalone amplifiers. 

 

2.2.2.2.2.3 Remove Panel or AV-AMP 

By selecting a previously Added Panel or AV-AMP, the Remove Panel (if Panel selected) or Remove AV-AMP (if 
AV-AMP selected) icon will become accessible. Once the Remove Panel or Remove AV-AMP icon is accessible, 
the user can remove the selected Panel or AV-AMP from the Panel/Amplifier List. 

     

2.2.2.2.3 Audio Icons 
Audio Icons allow the user to work with audio 
messages that have been added to an amplifier. Audio 
Icons include; Play, Stop, Remove Message, Remove 
Audio File, Import Audio File, Move Up and Move 
Down. 

Prior to adding a message, the only accessible icon is 
Import Audio File. Import Audio File allows the user to 
import a custom audio file to the program, refer to 
Import Audio File section of this manual. 

 

2.2.2.2.4 Communication  
Communication Icons include; Upload and Cancel. Prior to creating an audio file, for uploading, 
these icons are non-accessible. 

 

 

2.2.3 Panel/Amplifier List 
The Panel/Amplifier List area is where the user adds all of the amplifiers of an installation. As previously indicated, 
amplifiers can be within panels, connected to the panel AX-CTL base card PBUS remotely or be standalone non-
networked. As previously discussed, within the Panel/Amplifier List area, each Panel, AV-AMP, AV-VB and AV-
VBM accommodates a customizable label area, for defining location and purpose (32 characters). 
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Below is a Panel/Amplifier List (PBUS [RS485]) including networked amplifiers. The Panel/Amplifier List includes 
each possible Panel selection, including a Panel without integrated audio, with an AV-VB to panel attached to its 
PBUS (RS485) network. 

 

Below is a Panel/Amplifier List composed of each possible standalone amplifier selection (AV-VBM and AV-VB).  

 

Note:  Highlighting any product within the Panel/Amplifier List and clicking within the text area, will allow 
the user to define a more beneficial location/purpose text for the panel or amplifier (i.e. Lobby Command 
Center, Main FACP, Microphone Bus Amplifier, 1st Floor Amplifier, etc.). 
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2.2.4 Message Program Area 
The Message Program Area is where the user places the audio messages for a specific selected amplifier. The 
Message program Area includes; a Message section and three (3) Audio Sections.  

 

 

2.2.4.1 Message Section 
The Message section is where the user defines whether the message will be synchronized and how many times 
the Message will repeat. Default is Message Sync (synchronized) and continuous Repeats (). 

 

 

Note:  Only PBUS (RS485) amplifiers can be synchronized, standalone hardwired amplifiers cannot be 
intelligently synchronized. For synchronization of standalone amplifiers refer to Advanced AV-VBM and 
AV-VB Manual. 

2.2.4.2 Audio Sections 1, 2 and 3 
The Audio Section areas (1, 2 and 3) are where the user adds the specific messages the amplifier will broadcast. 
For PBUS (RS485) amplifiers, up to sixteen (16) messages can be added to each amplifier. For standalone, 
hardwired, amplifiers, only two (2) messages can be added. 

By incorporating three (3) Audio Sections, users can provide a leading Message/Tone, a main Message/Tone and 
a Trailing Message/Tone. Below is an example of a three (3) Audio Section message, based on NFPA 72 one-
way emergency communications system, evacuation tone (three rounds of a temporal 3 tone, followed by an 
evacuation message, followed by a three round temporal 3 tone, continuously repeated). 

 

As seen in the example above, each Audio Section contains a File Name and a Repeats section. 
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2.2.4.2.1 File Name 
File Name is the physical wave file name of the message or tone (i.e. Female Evac 1, Temporal Chime Loud, etc.) 
selected and added to the Audio Section: 

 

 

 

2.2.4.2.2 Repeats 
Repeats is the actual number of times, the user would like the File Name to Repeat. Of course within logical limits, 
Repeats range from infinity () to 99. Below is an example of three (3) Repeats for a File Name. 

 

2.2.5 Message Categories 
Message Categories are the seven (7) pre-assigned Audio File Categories where the physical wave files are 
stored. Categories include; Mass Notification, Fire Evacuation, Alert, Hazard Warning, All Clear, Custom and 
Tones. 

 

Note:  Within the Message Categories area, there is also a Most Recent utilized category that stores the 
last twelve (12) utilized wave files. 
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2.2.6 Category Messages 
Category Messages is the area where the specific Category Messages can be accessed. Below is an example of 
the Fire Evacuation Category Messages, the user is able to select one of these messages and placing it within the 
File Name area of the Audio Section. Scroll down/up arrows are available when multiple message files exist within 
the Message Category. 

 

3 Programming Amplifier(s) 
To program an amplifier the user should be aware of the following items: 

1. How many amplifiers are being utilized in the installation? 

2. Are the amplifiers networked (AX-CTL base card PBUS [RS485]) or standalone (hardwired)? 

3. Are all amplifiers going to have the same messages? 

4. Are there panels with or without an amplifier?  

5. Will the amplifier require backup? 

6. Are the messages within the Message Categories sufficient or will the user need customized 
messages? 

3.1 Programming Networked Amplifier(s) 
By design, networked amplifier installations automatically require more than one amplifier, as within the Advanced 
system (PC-NeT programming tool), a networked amplifier can be programmed as a Microphone Bus Amplifier 
(Mic Bus Amp), a Remote Mic Bus Amplifier (Remote Mic Bus Amp) or a Floor/Area Amplifier (Floor Amp). Each 
Advanced AxisAX panel can support sixteen (16) PBUS (RS485) networked amplifiers.  

Note:  A single amplifier (one PBUS [RS485] amplifier only) installation could be programmed as a 
Floor/Area Amplifier and have the keying of the microphone override the Floor/Area amplifier message. 
This way the installation could contain 16 messages and microphone override, however no selective 
control (addressable NAC module) would be possible to specific areas. The installation would be all call 
messages and paging only by keying the microphone. 

3.1.1 Adding a Panel 
With the AxisAx AV-AMP program opened, select one of the appropriate Add Panel options (Add Command 
Center, Add panel with integrated audio or Add panel without integrated audio). 

 
 

For our example, we have selected a Command Center Panel. By selecting a Command Center Panel, 
automatically one (1) amplifier is installed in the Command Center enclosure, by clicking on the plus  icon, of 
the Command Center, the user can expand the command center and access the integral amplifier for 
programming. 
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3.1.1.1 Microphone Bus Amplifier 
As this is an amplifier networked installation, the amplifier within the Command Center would be allocated as the 
Microphone Bus Amplifier (Mic Bus Amp) and it would be advantageous to label it as such. The Microphone Bus 
Amplifier requires no message uploading (standard factory installed messages are sufficient) as the amplifier is 
strictly utilized for a microphone bus. If however, the Microphone Bus Amplifier requires modification of the 
amplifiers Properties than the amplifier would have to be programmed with at least one message. 

 

3.1.1.1.1 Programming a Microphone Bus Amplifier 

3.1.1.1.1.1 Amplifier Properties 

Properties of the Microphone Bus Amplifier can be modified based on installation requirements. If for example, the 
amplifier required a one-to-one backup, the user would select Backup Mode Enabled within the Properties area. 

To program the Microphone Bus Amplifier Properties, click on the tools  icon of the amplifier, the following 
Properties screen will appear for the amplifier:  

 

As can be seen, the Properties screen includes the selection of three (3) functions related to the selected 
amplifier. These three property functions exist with any amplifier added to the AV-AMP programming tool. 

Standalone AV-AMP:  If the Standalone AV-AMP option were checked, it would make the amplifier a non 
networked PBUS (RS485) amplifier. As we selected a panel (Command Center) with an integral amplifier, 
automatically the program allocates this amplifier as a networked amplifier, hence the unchecked box. 

Backup Mode Enabled:  By checking the Backup Mode Enabled box, amplifier 2, of the AV-AMP-80 amplifier, 
would be a backup amplifier to amplifier 1. 
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Common PSU (DGP/Mx-VB2/4/8):  This selection is utilized when one AX-PSU-6 power supply charger is utilized 
for two (2) AV-AMP-80 amplifiers, with a maximum wattage usage of both amplifiers of 80 watts. With a 
Microphone Bus Amplifier this option may be beneficial, as this amplifier uses limited power. The additional power 
could be utilized for an additional amplifier (i.e. Floor/Area Amplifier), as long the maximum of 80 watts is not 
exceeded. In a panel amplifier this option will be preselected. 

3.1.1.1.1.2 Amplifier Message 

As previously indicated, if a Microphone Bus Amplifier requires programming at least one message will need to be 
programmed within the amplifier. 

To program a Microphone Bus Amplifier message select the amplifier by clicking anywhere on the amplifier, with 

the exception of the tools  icon. 

 

When the Microphone Bus Amplifier is selected, the Message Program Area becomes accessible. 

 

Note:  The Microphone Bus Amplifier could also be uploaded with the Floor/Area amplifier messages, 
even though none of these messages will be utilized. 
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Navigate to the Audio Files, Categories and select a category. In our example we have selected Fire Evacuation. 

 

Click and hold the message wave file required. In our example we have clicked on the Female Evac 1.wav file. 

 

While maintaining hold of the specific wave file message drag the file (cursor arrow) to the Audio Section 1, File 
New location and release the selection. The message will now be placed in the Audio Section 1, File Name 
message location of the amplifier.  

 

Once a message has been added to an amplifier, the Audio; Play, Remove Message and the Communication; 
Upload icons will become accessible.  

 

Play:  Allows the user to listen to the selected message on the PC, if PC speakers are available. 

Remove Message:  Allows the user to remove a selected message from the amplifier. 

Upload:  Allows the user, via a USB cable, to upload the messages to the amplifier.  

As this is the only message required for the Microphone Bus Amplifier in our example, the Microphone Bus 
Amplifier message can now be Uploaded to the Command Center amplifier. 

Connect a USB cable from the PC to the Microphone Bus Amplifier and click on the Upload icon. The message(s) 
will be transmitted to the associated amplifier. 
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Note:  While the PC is connected to the amplifier, via the USB cable, a ground fault condition will be 
present on the associated AX-PSU-6 power supply charger, as the USB port on the amplifier is not 
isolated. This ground fault condition will be transmitted to the AX-CTL base card as an amplifier power 
supply trouble.  

3.1.1.2 Floor/Area Amplifier 
As previously indicated, each AxisAX panel can support up to sixteen (16) PBUS (RS485), networked amplifiers, 
with sixteen independent messages. 

Note:  Networked AX-CTL base card PBUS (RS485) amplifiers can be wired Class B only. 

 

To add a Floor/Area amplifier to our existing installation example, click on the Add AV-AMP and select Add AV-VB 
to panel, as this will be a PBUS (RS485) networked amplifier. 

 

Once the amplifier is added, clicking within the amplifier’s text location allows the user to define a custom label for 
the amplifier (32 characters). In our example we have labeled the amplifier as a Floor/Area Amplifier. 

 

If all amplifiers are going to contain the same messages (PerfectSync between all amplifiers), than only one 
amplifier needs to be created for the Floor/Area amplifiers. The user would simply Upload this created amplifier 
messages to all installation amplifiers. 

3.1.1.2.1 Programming a Floor/Area Amplifier 

3.1.1.2.1.1 Amplifier Properties 

Properties of the Floor/Area Amplifier can be modified based on installation requirements. If for example, the 
amplifier required a one-to-one backup, the user would select Backup Mode Enabled within the Properties area. 

To program the Floor/Area Amp Properties, click on the tools  icon of the amplifier, the following Properties 
screen will appear for the amplifier: 
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Programming Properties include: 

Standalone AV-AMP:  As we have added the AV-VB to a panel automatically the Standalone AV-AMP is 
unchecked as this is a networked amplifier. 

Backup Mode Enabled:  By checking the Backup Mode Enabled box, amplifier 2, of the AV-AMP-80 amplifier, 
would be a backup amplifier to amplifier 1. 

Common PSU (DGP/Mx-VB2/4/8):  This selection is utilized when one AX-PSU-6 power supply charger is utilized 
for two (2) AV-AMP-80 amplifiers, with a maximum wattage usage of both amplifiers of 80 watts. In panel 
amplifiers this option is preselected. 

3.1.1.2.1.2 Amplifier Message 

To program Floor/Area Amplifier messages select the amplifier by clicking anywhere on the amplifier, with the 

exception of the tools  icon. 

 

When the Floor/Area Amplifier is selected, the Message Program Area will become accessible. 
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To add a message to the selected Floor/Area Amplifier, navigate to the Audio Files Categories and select the 
required Category and message.  

 

 

Note:  Amplifier messages are prioritized based on position within the amplifier, message 1 has a higher 
priority than 2, 2 a higher priority than 3, etc, etc (1 highest, 16 lowest priority). 

As previously discussed, each message added to an amplifier can have a leading tone/message (Audio Section 
1), a main tone/message (Audio Section 2) and a trailing tone/message (Audio Section 3). 

Below is an example of five (5) messages added to a Floor/Area Amplifier, with message 1 having the highest 
priority and message 5 having the lowest priority. We have indicated that with multiple amplifiers playing the same 
messages they will be synchronized, we have also indicated all messages will continue to play. 

 

Message files are added by clicking on a specific message wave file and dragging the wave file (using cursor 
arrow) to the Audio Section 1, 2 or 3 location and releasing the selection. 

Note:  The Floor/Area Amplifiers can accommodate up to sixteen (16) messages. Messages are added to 
the Message Programming Area based on installation requirements. 

Once messages have been added to an amplifier, the Audio; Play, Remove Message and the Communication; 
Upload icons become accessible.  

 

Play:  Allows the user to listen to the selected message on the PC, if PC speakers are available. 

Remove Message:  Allows the user to remove a selected message from the amplifier. 

Upload:  Allows the user, via a USB cable, to upload the messages to the amplifier. 

When the user is finished programming amplifier messages, simply connect a USB capable from the PC to the 
amplifier USB port and Upload the messages to the amplifier. If multiple amplifiers are going to contain the same 
messages Upload the additional amplifiers also. 
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3.2 Programming Standalone Amplifier(s) 
To program a Standalone Amplifier, select one of the appropriate Add AV-AMP options (AV-VB or AV-VBM). 

 

For our example we have selected an AV-VBM. 

 

Note:  As a Standalone Amplifier, the AV-VBM can only accommodate two (2) messages. These two (2) 
messages are activated by selecting input 1 or 2 of the AV-VBM amplifier. 

3.2.1 Amplifier Properties 

As this is a Standalone Amplifier, within the Amplifier Properties the Standalone AV-AMP will be automatically 

checked. To view and select additional Amplifier Properties, click on the tools  icon of the amplifier and the 
following Properties screen will appear.  

 

The Properties screen includes the selection of three (3) functions related to the selected amplifier. These three 
property functions exist with any amplifier added to the AV-AMP programming tool. 

Standalone AV-AMP:  As this is a Standalone Amplifier this option will be checked. 

Backup Mode Enabled:  By checking the Backup Mode Enabled box, amplifier 2, of the AV-AMP-80 amplifier, 
would be a backup amplifier to amplifier 1. 

Amp Supply Always On:  This selection is utilized when one AX-PSU-6 power supply charger is utilized for two 
(2) AV-AMP-80 amplifiers, with a maximum wattage usage of both amplifiers of 80 watts. 

3.2.2 Amplifier Message 

To program the AV-VBM amplifier messages select the amplifier by clicking anywhere on the AV-VBM, with the 

exception of the tools  icon. 
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When the AV-VBM is selected, the Message Program Area will become accessible. 

 

To add a message to the selected AV-VBM, navigate to the Audio Files Categories and select the required 
Category and message.  

 

 

Note:  Amplifier messages are prioritized based on position within the amplifier, message 1 has a higher 
priority than 2. Message 1 is activated when input one of the amplifier is active, message 2 is activated 
when input 2 is active. 

Each message added to an AV-VBM amplifier can have a leading tone/message (Audio Section 1), a main 
tone/message (Audio Section 2) and a trailing tone/message (Audio Section 3). 

Below is an example of two (2) messages added to an AV-VBM amplifier, with message 1 having the highest 
priority. As this is a Standalone amplifier, the indication of synchronization is irrelevant, Standalone amplifiers 
cannot be intelligently synchronized. 
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Message files are added by clicking on a specific message wave file and dragging the wave file (using cursor 
arrow) to the Audio Section 1, 2 or 3 location and releasing the selection. 

Note:  Standalone amplifiers can only accommodate two (2) messages and the AV-AMP programming tool 
will not allow the addition of other messages. 

Once messages have been added to an amplifier, the Audio; Play, Remove Message and the Communication; 
Upload icons become accessible.  

 

Play:  Allows the user to listen to the selected message on the PC, if PC speakers are available. 

Remove Message:  Allows the user to remove a selected message from the amplifier. 

Upload:  Allows the user, via a USB cable, to upload the messages to the amplifier. 

When the user is finished programming amplifier messages, simply connect a USB capable from the PC to the 
amplifier USB port and Upload the messages to the amplifier. 

3.3 Importing Audio Files 
Importing Audio Files to the AV-AMP programming tool requires that the audio file comply to the below 
requirements. If the audio file does not comply with the below requirements, the Import Audio Files screen will not 
allow the user to continue with the import process. 

File Type .wav 

Sample Rate 8000Hz 

Bits Per Sample 16 

Channels 1 (Mono) 

 

To Import an Audio File, click on the Import Audio File  icon, the following screen will appear: 
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Within the Import Audio File screen, select the down arrow  icon and select the appropriate Category you 
would like to store the Imported Audio File in. Category selections include; Mass Notification, Fire Evacuation, 
Alert, Hazard Warning, All Clear, Custom and Tones. 

 

Once the user has selected the Category to place the Imported Audio File, the user can Browse the PC to locate 
where the new wave file, meeting audio file requirements, is stored on the PC.  

 

Select the correct new wave file. If the audio file requirements have been met both the play  icon and OK 

  button will be accessible. In addition, the user can enter text within the Text area defining the 
message. 

 

By clicking on the OK  button, the message will be saved to the Audio Files Categories location for 
programming use. 

3.3.1 Converting Audio Files to AV-AMP Required Format 
Converting existing non AV-AMP compliant audio files can be done with any commercially available software for 
recording and editing sounds. One that Advanced has utilized is Audacity. Audacity is a free, open source, cross-
platform software for recording and editing sounds available at audacity.sourceforge.net. 

Below is an example of converting a non AV-AMP compliant audio file to a compliant one: 

Open the Audacity program and Open the audio file requiring conversion. In our example, we have opened an 
Audio Test Message wave file. The format of this wave file is 44100Hz, 16 Bit, Mono.   

 



 

 

www.advancedco.com
22 

As the AV-AMP requires a wave file 8000Hz, 16 Bit, Mono, we will need to change the hertz of the file. To change 
the Hertz, the user must resample the file to 8000Hz and than convert the message to 8000Hz. 

To resample the file, click on the Tracks tab and select Resample. Resample to 8000Hz. 

     

To change the message to 8000Hz, at the bottom of the screen click on the down arrow below Project Rate (Hz) 
and select 8000Hz. 

 

                                                

Once the file has been converted to an AV-AMP format export the file to a location on the PC for importing into the 
AV-AMP programming tool. 
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